
 PRO-Diary Guide to Getting Started 1.1 (May 2012)              1 

 

 

 

 

 

 

The PRO-Diary  

User Manual 

 

    Document Reference:  30119  

    Issue Version:   1.1 

    Issue Date:    30/05/2012 

 

 

 

 

 

 
CamNtech Ltd 

Upper Pendrill Court 

Papworth Everard 

Cambridgeshire 

CB23 3UY, UK 

Tel:  01480 831223 

Fax: 01480 831733 

Email:  technical@camntech.co.uk 

Web:   www.camntech.co.uk 

 

 

mailto:technical@camntech.co.uk
http://www.camntech.co.uk/


 PRO-Diary Guide to Getting Started 1.1 (May 2012)              2 

PRO-Diary – Medical device information: 
 

The PRO-Diary is not classified as a medical device according to the following 

rationale from the UK MHRA: 

“A ‘medical device’ means any instrument, apparatus, appliance, material or other article, 

whether used alone or in combination, including the software necessary for its proper 

application intended by the manufacturer to be used for human beings for the purpose of: 

 Diagnosis, prevention, monitoring, treatment or alleviation of disease, 

 Diagnosis, monitoring, treatment, alleviation of or compensation for an injury or 

handicap, 

 Investigation, replacement, or modification of the anatomy or of a physiological 

process, 

 Control of conception, 

And which does not achieve its principal intended action in or on the human body by 

pharmacological, immunological or metabolic means, but which may be assisted in its 

function by such means”. 

The PRO-Diary is an electronic patient diary; hence no medical claims are being 

made according to the above rationale. 

 

 

 

Applicable Standards: 
 

Standard Description 

EN60601-1-2:2002 Medical electrical equipment – Part 1-2: General requirements for safety – Collateral 

standard: Electromagnetic compatibility – Requirements and tests. 

Group 1 equipment / Class B – (emissions only)  

EN60601-1-2:2002 Medical electrical equipment – Part 1-2: General requirements for safety – Collateral 

standard: Electromagnetic compatibility – Requirements and tests. 

Non life supporting equipment (immunity section only)  

  

 

Safety Classification Information: 

 

The PRO-Diary is INTERNALLY POWERED EQUIPMENT. 

 

The PRO-Diary is a TYPE B APPLIED PART. 

 

 

 

 

For further safety and handling advice please refer to section 11 



 PRO-Diary Guide to Getting Started 1.1 (May 2012)              3 

Contents 
1 Introduction to the PRO-Diary System .................................................................................................... 5 

1.1 An Overview of the PRO-Diary System ............................................................................................... 5 

2 Installing the PRO-Diary Software ........................................................................................................... 6 

2.1 System Requirements ......................................................................................................................... 6 

2.2 Software Installation Menu .................................................................................................................. 6 

2.3 Users upgrading from an earlier version of  the Software .................................................................... 7 

2.4 Installing the USB Drivers .................................................................................................................... 7 

2.5 Using the software for the first time ..................................................................................................... 8 

3 Charging the PRO-Diary ........................................................................................................................... 9 

3.1 Charging the Diary from the PC ........................................................................................................... 9 

3.2 Charging Several Diaries from a USB Hub .......................................................................................... 9 

3.3 Charging the Diary using the Mains Power Supply .............................................................................. 9 

4 Editing Questionnaires .......................................................................................................................... 10 

4.1 Basic Concepts ................................................................................................................................. 10 

4.2 Questions .......................................................................................................................................... 11 

4.2.1 Multiple Choice ........................................................................................................................... 11 

4.2.2 Visual Analogue ......................................................................................................................... 11 

4.2.3 Enter a Number .......................................................................................................................... 12 

4.2.4 Enter a Time ............................................................................................................................... 12 

4.2.5 Just a Message .......................................................................................................................... 13 

4.2.6 List ............................................................................................................................................. 13 

4.2.7 Free Text .................................................................................................................................... 14 

4.2.8 Likert Scale ................................................................................................................................ 14 

4.3 Questionnaires .................................................................................................................................. 14 

4.4 Schedules ......................................................................................................................................... 15 

4.4.1 Day Designation ......................................................................................................................... 15 

4.4.2 Time/Type of Entry ..................................................................................................................... 15 

4.4.3 Motion Logging ........................................................................................................................... 15 

4.5 Locked and Unlocked Items .............................................................................................................. 16 

4.6 Creating a New Question Database .................................................................................................. 16 

4.7 Diary Menu Customisation................................................................................................................. 16 

4.8 Conditional Questionnaire Sequences ............................................................................................... 17 

4.8.1 Quick Summary .......................................................................................................................... 17 

4.8.2 Simple example (to omit some questions depending on a previous answer) .............................. 17 

4.8.3 Bigger example (to present a nested set of options) ................................................................... 19 

4.8.4 Random Ordering Example ........................................................................................................ 22 

5 Setting up a Diary ................................................................................................................................... 23 

5.1 User Name ........................................................................................................................................ 23 

5.2 Schedule ........................................................................................................................................... 23 

5.3 Question Size .................................................................................................................................... 23 

5.4 Menu Customisation .......................................................................................................................... 24 

5.5 Enable Keylock .................................................................................................................................. 24 

5.6 Enable Reaction Test Game ................................................................. Error! Bookmark not defined. 

5.7 Enable Demo Beeps.......................................................................................................................... 24 



 PRO-Diary Guide to Getting Started 1.1 (May 2012)              4 

6 Using the Diary ....................................................................................................................................... 25 

6.1 Waking it up ...................................................................................................................................... 25 

6.2 Using Menus and Answering Questions ............................................................................................ 25 

6.3 Answering a Scheduled Questionnaire .............................................................................................. 25 

6.4 Requesting a Questionnaire .............................................................................................................. 25 

6.5 Silent Mode ....................................................................................................................................... 26 

6.6 Not Waterproof .................................................................................................................................. 26 

7 Downloading Results ............................................................................................................................. 27 

8 Viewing Results ...................................................................................................................................... 28 

8.1 Filtering by Questionnaire .................................................................................................................. 28 

8.2 Transposing the Results Table .......................................................................................................... 29 

8.3 Filtering by Scheduled/Requested ..................................................................................................... 29 

8.4 Exporting Motion Logging Data ......................................................................................................... 29 

8.5 Other Exports/Data Analysis .............................................................................................................. 29 

9 Tutorial .................................................................................................................................................... 30 

9.1 Create a Schedule ............................................................................................................................. 30 

9.2 Waking Up ......................................................................................................................................... 32 

9.3 Going to Bed ..................................................................................................................................... 35 

9.4 Afternoon Tiredness .......................................................................................................................... 36 

9.5 Using the Schedule ........................................................................................................................... 36 

9.6 Downloading Results ......................................................................................................................... 37 

9.7 Demonstrating a Timed Questionnaire .............................................................................................. 38 

10 Frequently Asked Questions .............................................................................................................. 39 

11 Additional Documents ........................................................................................................................ 40 

12 Safety and Handling Information ....................................................................................................... 41 

12.1 De-contamination .............................................................................................................................. 41 

12.2 Battery ............................................................................................................................................... 41 

12.3 Water Ingress .................................................................................................................................... 41 

12.4 Disposal ............................................................................................................................................ 41 

Appendix A – Installing USB Drivers Manually ........................................................................................... 42 

To begin installing drivers: ........................................................................................................................... 42 

 



 PRO-Diary Guide to Getting Started 1.1 (May 2012)              5 

1 Introduction to the PRO-Diary System 

1.1 An Overview of the PRO-Diary System 

The PRO-Diary system consists of a wrist-worn electronic diary and associated PC 
software which can record the user’s answers to questions during daily living in a 
very flexible and easy to use way.  It can be used to monitor a wearer’s condition 
and symptoms before treatment, or detect a change in the wearer’s symptoms 
during or after intervention.  It can also be used to remind the wearer to take 
treatment at regular or irregular intervals or to record events when marked by the 
wearer.  The system is very flexible to different recording requirements for various 
areas of research. 
 
The PRO-Diary system includes:  
 

 PC software for designing questionnaires 

 USB connection for setting up, downloading and charging the Diary 

 The PRO-Diary itself, for wearing on the wrist or in the pocket 

 PC software for viewing and exporting recorded answers 
 
For up to date pricing and availability of these components, please contact 
CamNtech.  
 
The PRO-Diary is designed to be worn on the wrist with replaceable fabric straps or 
washable plastic straps available from CamNtech.  It uses standard sprung watch 
pins for the attachment so you can obtain alternative straps from any watch supplier.  
Either us or your watch supplier will also be able to assist if you are not confident 
inserting the spring loaded pins yourself. 
 
Each PRO-Diary contains a lithium polymer rechargeable battery. The life of the 
battery is very dependent on usage of the unit – more frequent and longer 
questionnaires will be more demanding. However it should be at least 30 days in 
commonly expected uses. It is easily recharged via the USB port or using a standard 
mains adaptor with a USB output. The USB interface is also used for setting up and 
downloading data to/from a PC. 
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2 Installing the PRO-Diary Software 
 

2.1 System Requirements 

The PRO-Diary system is supplied with a CD containing all of the components of the 
software package, and the drivers to support the hardware required by the system. 
The following are the minimum requirements of a host PC for installing the software:  
 

 Windows XP, Vista or Windows 7 operating system 

 500 MHz processor 

 512 MB RAM 

 500 MB hard disk space 

 USB port 

 A CD-ROM drive or equivalent 

 1024 x 768 pixel display 
 
In general, a faster processor and increased RAM will provide superior performance.  

2.2 Software Installation Menu 

Do not connect a PRO-Diary at this stage. 
Place the CD-ROM into the drive; the software should start automatically and display 
the following installation menu: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To install the software, click on ‘Install PRO-Diary PC Software’ and follow the 
installation process. Note that the installation will differ for new users and existing 
users as described in Section 2.3 below. 
 
If the above menu is not automatically displayed, browse the CD and run the file 
‘SplashMenu.exe’. 
 
Note that the software requires the Microsoft .NET framework to operate – this will 
be automatically installed if not present.  
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2.3 Users upgrading from an earlier version of  the Software 

Upon following the procedure described in Section 2.2, users upgrading older 
versions of software may be asked if they wish to repair or remove the existing 
version of the software when the new software installation is run for the first time. 
The option to remove should be selected and then the software installation run for a 
second time to install the new version as described in Section 2.2. 
 
A message warning that ‘Publisher cannot be verified’ may be displayed – click ‘Run’ 
to accept. (this is a Windows security warning and is not a problem). 
 

2.4 Installing the USB Drivers 

If the Installation menu is not already displayed, insert the supplied CD ROM into the 
CD/DVD drive on the host PC then plug the PRO-Diary USB cable into a free USB 
Port. The Installation menu should be automatically displayed (as shown in Section 
2.2).  
 
Depending upon the operating system in use and the current driver status, the 
computer may display a message saying ‘Found New Hardware’ and will then load 
the drivers with no user intervention. If the drivers loaded automatically, simply close 
the installation menu and the drivers should be ready to use. 
 
If the drivers do not load automatically, or if you wish to make sure they install 
correctly, you should select ‘Install CamNtech USB Drivers’ and carefully follow the 
on-screen instructions. If you still experience problems with the USB drivers, follow 
the procedure ‘Installing USB Drivers Manually’, which is included in Appendix A of 
this manual. 
 
Windows should automatically search the CD drive for the driver, but if it does not do 
so you will be required to ‘Search manually’ and then ‘Browse’ to point to the CD 
drive.   
 
A screen may appear that tells the user that the driver is not digitally signed by 
Microsoft.  Select ‘Continue Anyway’ (Please note that this is NOT a problem and 
just means that the CamNtech version of the driver software has not been assessed 
by Microsoft.  In fact the actual drivers are Microsoft approved).  The drivers will be 
installed and the computer will then tell the user that the new hardware is ready to 
use. If you change the USB port that the reader is plugged into then the driver may 
be automatically re-installed by Windows.  This is an automatic process and the user 
need take no action. 
 
If you have any problems installing the drivers, please read the help document and 
download the latest drivers from http://www.camntech.com/drivers. 
 

http://www.camntech.com/drivers


 PRO-Diary Guide to Getting Started 1.1 (May 2012)              8 

2.5 Using the software for the first time 

Double clicking on the PRO-Diary icon on the desktop will start the software.  This 
will display the main menu as shown below.  Each option is introduced in a section 
of this guide. 
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3 Charging the PRO-Diary 
 

Before the Diary can be used, the user must ensure that it is fully charged.  You may 
charge it either from the PC or a separate USB hub.  In either case it will take 
around 3-4 hours to be fully charged. 

3.1 Charging the Diary from the PC 

Connect the Diary to a free USB port and it will be automatically charged from the 
PC.  If you connect multiple Diaries to the same PC at the same time, windows will 
attempt to find extra drivers.  This will generate windows/warnings which can be 
safely cancelled.  You may only communicate with a single Diary but as long as your 
PC is capable of it, several should charge together. 

 

3.2 Charging Several Diaries from a USB Hub 

A USB extension hub may be more convenient to charge several Diary devices at 
once without requiring a PC to be connected.  This hub must be powered by a 
separate mains adapter itself.  CamNtech have tested the Diary with a Belkin 4-Port 
Hub; other hubs with a separate mains adapter are also likely to work, but 
CamNtech have not tested against them. 

 
 

3.3 Charging the Diary using the Mains Power Supply  

 
The PRO-Diary may be recharged using a mains adaptor with a standard USB 
power output (the type often used for charging MP3 players or phones). 
 

1. Select and fit appropriate ac input socket adaptor for country of use. 
2. Plug the USB cable from the Diary directly into the socket on the mains 

power supply adaptor. 
3. The Diary will be automatically charged. 



 PRO-Diary Guide to Getting Started 1.1 (May 2012)              10 

4 Editing Questionnaires 
 

The Diary is set up using a combination of questions, questionnaires, and 
schedules.  It is easiest to familiarise yourself with these by exploring the examples 
included with the PC software.  After clicking on ‘Edit Questionnaires’ in the main 
menu, you will be presented with the quick view window, as shown in the example 
below.  You can explore this tree by right-clicking or double clicking on various items 
to get an idea of how the system operates.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.1 Basic Concepts 

It may be useful to clarify the terminology used in programming the Diary: 
 
The diary presents the user with questions, either at specific times or when the 
wearer requests it, and logs their answers.  ‘questions’ are grouped together into 
‘questionnaires’, and a ‘schedule’ instructs the diary when to offer each 
questionnaire to the wearer.   
 
A ‘question’ is the basic question presented to the wearer.  It may be one of half a 
dozen basic types, and includes the question itself and various optional answers, or 
default settings for entering numbers, times, etc. 
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A ‘questionnaire’ is a sequence of questions.  It may, optionally, include more 
complicated instructions for skipping or jumping around in the sequence depending 
on the answers to some questions. 
 
A ‘schedule’ is a list of schedule entries, each with a time and day, that tell the diary 
to do something at that time.  These may prompt the user, or simply make available 
a user-requested questionnaire during a given period.  They may also apply to 
‘every Tuesday’ or ‘every weekday’ rather than a specific day. 
 
It will be easiest to set up your first test recording using one of the example 
schedules provided, rather than having to create your own first. 
 

4.2 Questions 

There are eight types of questions: 
 

 Multiple choice 

 Visual analogue 

 Enter a number 

 Enter a time 

 Just a message 

 List 

 Free Text 

 Likert Scale 
 
All types include a main ‘question’ message, but a selection of different answer 
mechanisms. 

4.2.1 Multiple Choice 
For example: “Which fruit do you prefer?”, with possible answers of “Apples”, 
“Oranges”, or “Other”.  
 

 
  
Each question has 1-8 answers.  The user positions the slider directly by tapping or 
dragging, and the chosen answer is taken from this.  The currently selected answer 
is displayed at the bottom of the screen just above the slider bar.  This is the easiest 
way to question the user for up to around 5-6 answers, but above that the list may 
be less fiddly to operate. 

4.2.2 Visual Analogue 
For example: “How difficult is it to touch your toes?”, with the text “Easy” at the left 
hand end of the slider bar and “Hard” at the right hand end. 
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The user positions the slider directly wherever they feel is appropriate between the 
two ends.  These ends are described by extra prompts, displayed just above the 
slider bar.  Ideally these should be short enough to fit at each end of the bar with a 
gap in the middle.  If it is longer than that it will be repeatedly scrolled through, but 
this is not ideal. 

4.2.3 Enter a Number 
For example: “What is your weight in kilograms?”, with the answer 53 displayed 
below and a range up to 120. 
 

 
  
The user drags the slider left or right to change the displayed number until they are 
happy with the answer.  They may also hold it at either end to scroll up or down 
continuously. 
 
Questions include a default value, decimal point position, and minimum and 
maximum values.  The decimal position specifies how many digits to include after 
the decimal point.  When you are editing an ‘Enter a number’ question, a message 
will be displayed explaining the current meaning of your settings. 

4.2.4 Enter a Time 
For example: “What time did you wake up this morning?”, with a time of “07:07” 
displayed. 
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This functions similarly to ‘Enter a number’, except as the user drags the slider the 
displayed time changes.  They can move it until they are happy with the displayed 
time, to an accuracy of 1 minute in 24 hours.  Dragging off the beginning or the end 
of the 24 hours results in the time wrapping round.  The Diary automatically starts 
with the current time when the question is asked.   

4.2.5 Just a Message 
For example: “Please take one blood pressure pill now” with no additional 
information or prompt. 
  

 
 
No extra parameters are needed, and no answer may be selected.  The main 
question is simply displayed in the middle of the screen until OK is pressed. 

4.2.6 List 
For example: “What activity are you doing right now?” with a list of 20-30 activity 
types to select from. 
 

 
  
The Diary will display the question along with part of the list and a scrollbar to 
indicate the user can scroll up or down the list by dragging their finger on the slider.  
They may also hold their finger at either end for a period to scroll continuously.  This 
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interface makes it much easier to present a larger number of options, but is a little 
more complex for simple questions.  It cannot be combined with the large text setup 
option, as the screen of the Diary is not large enough. 

4.2.7 Free Text 
For example: “What did you just eat?” with the ability to type in any text as an 
answer.   
 
This is much slower to input than any other question type, but may be invaluable if 
you really need to capture any possible answer to a single question. 
 
The Diary will present the question along with a compressed alphabet.  To select a 
letter, place your finger approximately under that letter.  The alphabet will begin 
zooming in.  Keep ‘steering’ your finger onto the correct letter as it zooms.  Once a 
box appears around the letter, you can release your finger and the letter will be 
added to your answer.  If you become confused when zooming in, simply release 
your finger early to cancel.  If you do enter an incorrect letter then simply select the 
symbol to the left of the main alphabet, ‘DEL’, to delete the previous letter. 
 
Because the free text entry is considerably slower and more difficult to operate than 
other question types, you should only use it if necessary and if you believe your 
target population will be comfortable with it.  You will need to demonstrate the free 
text entry to users before they can operate it. 

4.2.8 Likert Scale 
For example: “How much do you like fruit?” with a scale of five answers. 
 

 
  
This allows the user to select from a numerical scale, whilst also attaching a small 
text description to each level.  The text is displayed above the selected number 
scale similarly to a multiple choice question, but with the addition of the highlighted 
number display below. 
 

4.3 Questionnaires 

A questionnaire can simply be a list of questions, in the order they should be asked.  
The user will be asked the question at the top of the list first, and proceed down the 
list one by one.  This is all that is required if the user should be asked all of the 
questions every time. 
 
Simple questionnaires can be designed for the PRO-Diary by dragging questions 
from the available list at the bottom of the window into the main list.  The questions 
can be placed directly where they are wanted in the sequence, or re-ordered later by 
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dragging them up or down the list.  To remove a question, simply drag it back onto 
the available list below. 
 
It is also possible to design questionnaires with more complex sequencing once the 
‘advanced mode’ of the questionnaire editor is enabled.  The question sequence 
may then be modified by the user’s answers to a multiple choice question.  In this 
case, each alternative answer to the that question may have a different following 
question number attached to it.  This allows a ‘detail’ section to be skipped if it is not 
relevant.  This is described in more detail in section 4.8.  

4.4 Schedules 

A schedule consists of a list of schedule entries, and an optional motion logging 
configuration.  Each schedule entry makes a questionnaire available at a certain 
time or times, either prompting the user or simply being available on the menu when 
the unit is woken.  Every entry consists of a questionnaire, a day designation, and 
time/type of entry. 

4.4.1 Day Designation 
Each entry is applied on certain days, chosen from the options below.  Thus, any 
single schedule entry may cause the Diary to act on many days throughout a 
month’s recording rather than just one. 
 

 Every day 

 Every weekday 

 Every weekend day 

 Every Monday, Tuesday, … or Sunday 

 Day n of the recording (n from 1 to 30) 

4.4.2 Time/Type of Entry 
Entries may be marked to prompt the user either at a fixed time, or at a randomly 
allocated time within a certain period.  This can be used to avoid consistently 
prompting at exactly the same time every day, when the user might normally be 
busy or begin to expect the prompt. 
 
Entries may also be marked as ‘On request’ during a period of time.  This means 
that if the user wakes up the Diary at any time during that period then they can 
choose to answer the questionnaire at that time, rather than waiting for an alarm.  
They can then for example tell the Diary that they have woken up, eaten, or intend to 
go to bed now. 

4.4.3 Motion Logging 
Motion logging may be enabled as part of the schedule.  This will cause the Diary to 
record how much it is moved throughout the day, logging at a chosen “epoch” 
interval of between 1 and 60 seconds.  The resulting data can be used to monitor 
sleep or daytime activity profiles, and analysed using the CamNtech MotionWare 
software package.   
 
The “Actiwatch-compatible counts” mode records movement in a measure 
compatible with previously-existing “Actiwatch” products.  This measure is well 
validated for sleep monitoring, and has been used for daytime activity monitoring 
also.  In future updates an additional mode refined for activity intensity monitoring 
may be introduced. 
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4.5 Locked and Unlocked Items 

When an item has just been created (either a question, questionnaire or schedule), it 
is considered to be ‘unlocked’.  It will remain unlocked as you edit it and combine it 
with other items.  When you first use an item when setting up a Diary, all the used 
items will be locked.  This is necessary so that you have an accurate record of 
exactly what went into setting up each Diary, in order to interpret the data 
downloaded from it.  If you subsequently decide you did not want exactly the same 
setup, but a slight variant on it, you must right click and ‘Create Copy’ to create a 
new unlocked copy with a slightly different name.  This copy can then be modified.  
This allows you to keep track of your progress with modified options, as each one is 
stored separately with a version number tagged on the end of the item name. 

 

4.6 Creating a New Question Database 

When you want to begin work on your own set of questions and schedules, you can 
create a new database file to contain these.  This way it will not be cluttered up by 
the examples or any questions you have previously created for a different purpose.  
To do this, use the ‘File -> New Question Database…’ option in the quick view 
window.  You can later switch between question databases using ‘File -> Open 
Question Database…’.  Your current database file is also shown in the quick view 
window. 

 

4.7 Diary Menu Customisation 

There is an option in the File menu of the quick view window for menu 
customisation.  This allows you to change the text shown by the Diary during 
common actions.  You can use this to translate the menu text of the Diary to a 
different language.  You can also use it simply to clarify or slightly change the 
English messages if you wish.  Once you have created a set of menu customisations 
using this option, you must select one from the drop down list when setting up a 
Diary in order to make use of it. 
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4.8 Conditional Questionnaire Sequences 

Simple questionnaires can be designed for the PRO-Diary by dragging questions to 
and from the available list.  The questions will always be asked one after the other 
from the top to the bottom.  They can be re-ordered by dragging them up or down 
the list.  However, it is also possible to design questionnaires with more complex 
sequencing once the ‘advanced mode’ is enabled.  This section describes how to 
create and modify questionnaires with different sequencing. 
 

4.8.1 Quick Summary 

 Select a question to see its answers 

 Each answer has an arrow showing which question will then follow if that 
answer is chosen 

 Drag an answer to a different place in the questionnaire to create a link for 
that answer 

 Do this for as many answers as you want to 

 If you want all answers to lead to the same place, drag the ‘- Drag here to 
redirect all answers –‘ item 

 If you want to remove your links, so all answers just lead to the question 
below, press the button for ‘Clear links from this question’ 

 A sequence of questions can be marked for random ordering, but only if 
there are no conditional links within them. 

 
Note that: 
 

 You can only create a split in the sequence using a multiple choice question, 
because only these have several different answers 

 Small arrows will be added to the side of the question list whenever an 
answers leads anywhere except the question below 

 You can drag answers to just below the bottom of the list to direct straight to 
the end of the questionnaire 

 

4.8.2 Simple example (to omit some questions depending on a previous answer) 
In the first example, we show how to make a part of the questionnaire optional, 
depending on the answer to a question.  First, drag all the questions you want into 
the questionnaire.  An example with four questions is shown below, with the second 
question selected: 
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You can see the question ‘Have you experienced any pain today?’ is highlighted, 
and a box is displayed to its right including the answers ‘Yes’ and ‘No’ from that 
question.  Both of these answers have arrows leading from them to the next 
question in the main list.  This means that giving either answer will lead to the same 
following question, which is always the default.  However, we would like to omit the 
next question if the answer is ‘No’. 
 
Move the mouse cursor over the ‘No’ answer, and press and hold the left mouse 
button to drag it from here over the question list to the left.  As you do this you will 
see the mouse pointer change, and the target question is highlighted.  Release the 
mouse to ‘drop’ the answer on the question ‘Have you been very active?’.  The 
window will now look as below. 
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As you can see, there are now changes in the arrows to show the new question 
sequence.  The arrow from the ‘Yes’ answer still leads to the immediately following 
question, but the arrow from ‘No’ now leads to the new target question.  So the user 
will move to a different next question depending on their answer at this point.  In 
addition, a small arrow has appear to the left of the main question list to show an 
alternative sequence is present here.  You can always see the exact sequence by 
selecting a question to reveal the answers. 

4.8.3 Bigger example (to present a nested set of options) 
You may wish to allow the user to select from a larger number of options, but have 
them organised in a logical structure rather than a longer list.  One way to present, 
for example, ~20 answers would be as a nested set of questions.  To ask what the 
user is doing right now, the answers could be divided into a number of categories, 
with options within them: 
 
Work 

 Sitting at a desk 

 In a meeting 

 Manual work 

 Other 

 Home/Leisure 
Housework/DIY 

 Talking to friends/family 

 Watching TV 

 Outdoor activity 

 Indoor exercise 

 Other 
Travelling 
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 Driving 

 Public transport 

 Walking 

 Cycling 

 Other 
Eating 

 Breakfast 

 Lunch 

 Dinner 

 Other (small meal) 

 Other (large meal) 
Other 

 Physically active 

 Inactive 
 
The category can then be chosen with a single ‘top-level’ question.  The answer to 
this then determines which category question will be shown.  With questions entered 
for the top-level, and each of the categories above, the questionnaire design window 
looks like this: 
 

 
  
As can be seen, there are no arrows within the list because it is currently still a 
straightforward sequence from top to bottom.  The top question is selected, but 
every answer from it is pointing at the question just below. 
 
Next, we wish to create links so that the correct question will be jumped to next, 
depending on the answer to the first question.  So, using the mouse: 
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 Drag the ‘Work’ answer onto the work activity question 

 Drag the ‘Home/Leisure’ answer onto the home/leisure question 

 Drag the ‘Travelling’ answer onto the travelling question 

 Drag the ‘Eating’ answer onto the eating question 

 Drag the ‘Other’ answer onto the ‘other activity’ question 
 
The window should now look as below, showing each answer leading to a different 
one of the questions below.  There is also a set of arrows down the left of the 
question list summarising the same thing.  (The link between the 1st and 2nd 
question is not shown, as the list would be very cluttered if these were always 
shown) 
 

  
 
We now need to ensure that the user will jump to the correct following question after 
their ‘category question’.  Otherwise they will simply step down the list and be asked 
all of the questions below it.  To start this, first select the ‘What best describes the 
work activity you are doing?’ question.  Now use the mouse to drag the special entry 
at the bottom of the answers list onto the very bottom of the questionnaire (below the 
last question).  You should then see this: 
 

 
  
Here, you can see that every answer to the ‘work activity’ question now points to the 
line just below the bottom of the question list.  This means that they will go to the 
end of questionnaire straight away, with no further questions.  Obviously there could 
be a sequence of other questions here below the categories instead. 
 
Select each of the category questions in turn, and drag each of their ‘- Drag here to 
redirect all answers –’ to below the bottom of the questionnaire.  You should now 
see: 
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Note that this completed set shows both a set of arrows down the left from the first 
question, and a set down the right leading from each of the category questions to the 
common following point below (which happens to be the end of this questionnaire).   
 
Using conditional/linked questions, we now have a questionnaire where the user can 
choose between 22 different options based on a logical set of categories, rather than 
having to scroll through a long single list.  Obviously the better choice will depend on 
your application, but the Diary can support either method. 
 

4.8.4 Random Ordering Example 
To avoid the wearer becoming fatigued with a certain set of questions, it is possible 
to randomize all or part of a questionnaire.  To do so, first enable the advanced 
mode, then click just to the left of each question to display a dice symbol next to it.  
Any contiguous block of questions labelled with the dice will then be placed in 
random order each time they are scheduled.  In the example shown below, the three 
central questions will be randomized, but the other questions will not. 
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5 Setting up a Diary 
 
Selecting the option to ‘Set up a Diary’ from the main menu will result in a window 
similar to that shown below.  This shows the various setup options available.  These 
options will be affected by the currently opened question database – i.e. only 
schedules and customisations from the current question database will be available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
There are a number of options: 

5.1 User Name 

This field can be used to enter the wearer’s name or any patient/volunteer ID 
number you wish to be stored in the Diary to identify the wearer.  It will not affect the 
setup, but will be stored along with the data when the Diary is downloaded after use. 
 

5.2 Schedule 

This determines which questionnaires will be available or prompted for at what 
times, once the Diary is set up.  All the available schedules in the current question 
database are listed.  Additional schedules can be created or edited using the ‘Edit 
Questionnaires’ option.  The ‘Request Demo’ schedule in the example database will 
make a demo questionnaire available on request as soon as the Diary is set up. 
 

5.3 Question Size 

Text can be displayed on the Diary in the standard size, or a large version.  The 
large option may be useful if you are working with a group of wearers who have 
difficulty with the standard text size.  However, it is a compromise as text will take 
longer to read as it scrolls across the display. 
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5.4 Menu Customisation 

As introduced previously, this allows translation or modifications of the standard 
pieces of text in the Diary if you wish.  If you have created a new customisation, it 
will be available in this list.  Otherwise you should select ‘Default’. 

5.5 Enable Keylock 

The Diary may be carried in the pocket as an alternative to being wrist worn.  In this 
case you must enable this keylock to prevent accidental data entry.  This will require 
the wearer to smoothly run their finger across the slider before accessing the Diary.  
(they may move their finger relatively quickly or slowly for this, it is only important 
that they move it across the slider at a steady rate) 
 

5.6 Enable Demo Beeps 

You will normally leave this option disabled.  When training your users, it may be 
useful to have a ‘training’ Diary set up to demonstrate to them what will happen 
when they are wearing it.  If this option is enabled, then a function is created at the 
right hand end of the system information menu to artificially begin a beeping 
questionnaire.  When you activate this, the Diary will begin beeping just as if a timed 
questionnaire had been scheduled for exactly that moment.  You then hand the 
Diary to the new user and talk them through responding to the questionnaire.  The 
questionnaire shown will be the first one available on request at that point in time.  If 
there are no questionnaires available on request, this function will do nothing.  You 
will probably want to combine this option with a schedule designed just for 
training/demonstration. 
 
 
Once you are happy with the options selected, click on ‘Set up Diary’ to set up the 
Diary currently connected to the PC.  Only one Diary must be connected at this 
point.  
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6 Using the Diary 
 
The Diary is designed to be as simple and intuitive to use as possible.  This section 
guides you through basic use in case of any difficulty.  We recommend that you 
demonstrate the use of the Diary in front of each volunteer before a trial, and then 
ask them to work through your questionnaire on it whilst you are available to answer 
any questions.  This may be easiest to arrange with a spare ‘teaching diary’ which is 
already set up to have a relevant questionnaire available on request. 
 

6.1 Waking it up 

Once it is set up, the Diary can be woken by placing your finger across the left hand 
button with the triangular icon, and leaving it there for 1-2 seconds.  You should not 
use any force, simply place your finger over the button for the time required. 
 
If the ‘keylock’ function has been enabled, you will then be prompted to swipe your 
finger smoothly across the slider below the screen.  You may do this quickly or 
slowly and in either direction, but your finger must move at a steady speed. 
 

6.2 Using Menus and Answering Questions 

Once you have woken the Diary you can choose between options in a menu by 
putting your finger on the slider and moving it around to the left or right.  The slider is 
always used to explore or change options, and will never actually activate anything, 
so you can operate it freely without fear of changing anything.  Once you are happy 
with the option or answer displayed, select it by putting your finger on the round 
button to the right of the screen. 
 

6.3 Answering a Scheduled Questionnaire 

When scheduled, the Diary will beep repeatedly to alert the wearer that there are 
some questions to answer.  They may then choose (by moving their finger across 
the slider) to either answer the questions immediately, wait a few minutes, or cancel 
the session entirely.  As above, once they have chosen their favoured option they 
simply put their finger on the right hand button to activate it. 
 
If the wearer chooses to delay the question session for a few minutes, they can 
manually re-wake the Diary at any point during that period to begin answering the 
questions. 
 

6.4 Requesting a Questionnaire 

If a questionnaire has been made available on request, the user may open it 
whenever they choose.  It will be available in the main menu when the Diary has 
been woken normally, as one of the first items in the menu (before the silent mode 
and system information options).  If they select it, they will begin answering that 
questionnaire.   
 
This can be used for reporting a painful incident, or exercise taken, or food eaten, 
etc.  Because of the nature of these events, the user can choose to enter as many 
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such events as they like whilst the questionnaire is available on request.  All will be 
recorded.  This may be valuable or even essential to capture important data.   
 
However, be aware that it may make it more difficult to process the final results data 
in a regular manner. 
 

6.5 Silent Mode 

The Diary may be set to silent mode from the main menu after waking it.  To do this, 
move your finger until the ‘Enter silent mode’ option is displayed, and activate it with 
the right hand button.  The option will then be renamed to ‘Quit silent mode’.  This 
confirms that you are now in silent mode.  The Diary will remain in silent mode until 
the wearer activates the option again to change it back.  Obviously, you would 
encourage your volunteers to use this mode sparingly, but it is a better alternative to 
leaving the Diary behind somewhere (where it may be forgotten) when going to a 
meeting or similar. 
 

6.6 Not Waterproof 

Anybody wearing or carrying the Diary must be warned that it is not fully waterproof, 
mainly due to the presence of the USB socket.  With the USB bung fitted, it will 
withstand accidental splashes in daily use, but it must be protected from any greater 
exposure to water. 
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7 Downloading Results 
 
After the end of a trial with the Diary, the results can be downloaded to your PC for 
analysis.  For convenience, results are stored in a database file, so that you can 
keep many downloads together in one file.  You can then also create a new file 
when you want to group together another series of downloads.  A default results 
database file is created when you first use the software. 
 
To download data, connect the Diary to the PC and click on ‘Download Results’.  
The data will be downloaded to the current results database, and a popup window 
will confirm when the download is finished.  This is normally very quick, and will look 
as  shown below when successful. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you wish to create a new results database you should use ‘File -> New Results 
Database…’, after which the new database will be selected.  You can then change 
your currently selected database as you wish using ‘File -> Open Results Database’.  
This setting will affect both where your data is downloaded to, and the database 
which will be opened when you click on ‘Open Result Viewer’. 
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8 Viewing Results 
When the ‘Open Result View’ option on the main menu is clicked, the software will 
display a list of all the downloaded data in the currently selected result database.  If 
you want to look in a different result database, use ‘File -> Open Result Database…’ 
before selecting the viewer option. 
 
You can open any entry in the results list by double-clicking on it, or selecting it then 
clicking ‘Open’.  However, you must have a copy of the question database which 
was used to set up the Diary for each entry.  The software will attempt to find this 
automatically when you try to open an entry; if it cannot do so then it will ask you 
which question database it should look in to find the Diary setup. 
 
Once you have opened a download, you will see results similar to the image below.  
This is a table of all the answers the Diary recorded.  The contents of the table can 
be changed using the filtering functions described below, and the data can then be 
exported using the button in the bottom right of the window.  This will create a plain 
text table which can be pasted directly into Excel to create a spreadsheet of results, 
or used for your own analysis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.1 Filtering by Questionnaire 

The table can either be used to display a row for every set of answers, or only those 
from a specific questionnaire.  Showing every set is comprehensive, but does not 
allow the answers to be shown, as these would require different sets of column 
headers.  Choosing a specific questionnaire will show all the answers given to that 
questionnaire.  Most of the individual answers are self-explanatory, but the visual 
analogue value is given as a decimal value between 0.00 and 1.00, with the former 
corresponding to the left hand end of the scale and the latter to the right hand end. 
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8.2 Transposing the Results Table 

Depending on the aspect of data you are looking at, it may be more convenient to 
have the table arranged with a swap of columns and rows.  You can choose 
between these slightly different tables using the ‘List entries down side’ and ‘List 
entries across top’ options.   
 

8.3 Filtering by Scheduled/Requested 

You can use the drop down list in the options area to filter just those entries which 
relate to scheduled entries (even if they are refused), or only those which the user 
had requested.  By default, all entries are shown. 
 

8.4 Exporting Motion Logging Data 

If the Diary recording contains motion logging data in addition to the questionnaire 
results, the results window will contain a button for accessing that additional data.  
This can be used to save the data for the MotionWare analysis software (as a 
Motion format file), or optionally in an Actiwatch-compatible format for analysis with 
your existing sleep software.  The latter format will not save some details of the file 
data, particularly only marking questionnaire times to a per-epoch resolution, and 
having no method of marking data periods “missing” rather than simply zero, but is 
adequate for most analysis.  Note that you can save in several formats 
simultaneously by leaving them selected.  The raw recording is also kept in the Diary 
software, so can be re-exported using this method at any point. 
 

8.5 Other Exports/Data Analysis 

The data viewing and export interface is designed to be functional for those who 
wish to analyse their own data.  However, there are many different methods to 
proceed with that analysis.  If you need more assistance with your data analysis 
please contact CamNtech to discuss this; we may be able to make some 
arrangement to assist you.  
 
If you are performing your own data analysis, but require clarification of the data 
export or want some raw information which appears to be missing from the export 
interface, please contact us.  
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9 Tutorial 
The PRO-Diary motion is designed to provide a flexible package combining 
accurately logged subjective results with epoch-by-epoch actigraphy data.  This 
allows a uniquely integrated approach to data collection for sleep and lifestyle 
monitoring, but inevitably makes the system slightly more complex to configure.  
This tutorial leads the researcher step-by-step through a simple sleep 
monitoring configuration; it is recommended that you work through it as an 
introduction to the system. 
 
The system will be set up to monitor sleep using a few features, introduced here 
step by step: 
 

 Epoch-by-epoch motion logging. 

 Subjective sleep information collected at lights out and getting up times. 

 An extra mid-afternoon questionnaire to assess sleepiness. 
 
You can omit the motion logging if you do not need it for your application or are 
using a PRO-Diary without the feature. 
 

9.1 Create a Schedule 

Start the PRO-Diary software, and click on the “Edit Questionnaires” option.  Then 
create a new question database using the File menu: 
  

 
 

You can create the database in the default folder, or in whatever location you 
choose on your computer.  Putting your new work into a new database like this 
simply avoids confusion with any existing questions.  
 
Next, we will create a new “Schedule”.  This is a set of instructions saying when and 
how the Diary should collect data.  Use the “Add” menu or right click on the main 
window area to find the New Schedule function: 
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The software will display a blank new schedule.  You should then edit the schedule 
as shown below: 
 

 
  
The red circle highlights the schedule name – this is fairly self-explanatory and 
allows you to refer to several schedules within the question database.  It must be set 
to something meaningful before saving the schedule, but is not otherwise important. 
 
The blue circle shows settings controlling the motion logging of the PRO-Diary 
device, and in this example is set to record Actiwatch-compatible counts on a 15 
second epoch.  This means that a single number will be recorded every 15 seconds 
summarising how much movement there was within that period.  The Actiwatch 
compatible mode is designed to recreate a compatible measure which is already 
well validated for sleep use.  In future software there may be additional measures 
targeted more for the intensity of daytime activity. 
 
You can now save the schedule if you wish (with no entries listed in the central part 
of the window), or leave it open for now. 
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9.2 Waking Up 

Next, we will create a questionnaire for the user to complete after they wake up.  
This both collects subjective data at the start of the day, and additionally places a 
mark in the resulting actigraphy data which makes analysis easier (in exactly the 
same way as the marker button on simpler actigraphy devices).   
 
First, return to the Questionnaire Management window and use the Add menu (or 
right click in the main window) to create a new Questionnaire: 
 

 
  
This will create an empty new questionnaire, as shown below.  First change the 
questionnaire name to “Morning” as in the red circle.  This is not just the name 
shown when editing, but also the name of the item which the user must choose from 
the Diary menu in the morning, so it must be short and appropriate.  Next use the 
blue highlighted button to create a first question for the questionnaire. 
  

 
  
We will simply create an example question which could be asked of a user at the 
start of each day.  It is best to become familiar with this interface by experimenting 
with the different question types available, but for now follow step-by-step 
instructions to create the question below: 
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Configure the parts circled in red above: 
 

1. Type in the question “Did you sleep well?” 
2. Ensure the “Multiple Choice” question type is selected 
3. Select the fourth mark down on the left to enable four answer boxes to the 

right 
4. Fill in the answers as suggested 

 
Note the preview window on the right.  This allows you to see how well the question 
and answers fit on the screen of the PRO-Diary.  You can move your mouse across 
the selection bar below the display of the Diary to show different answers.  If the 
preview window is not visible you can create it using the drop-down in the bottom left 
of the question window. 
  
Click “Save” in the question window to add the question to the Morning 
questionnaire.  You can then continue do add more questions if you wish, 
experimenting with other question types.  Then save the questionnaire using the 
“Save” button circled in red: 
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Next, we will add the “Morning” questionnaire to the schedule, so that it will be 
available for the user to select in the morning.  Return to the schedule window, or 
double-click the schedule in the Questionnaire Management window if you had 
already saved it.  Then click on “Add new entry…”: 
  

 
 

The questionnaire and “Every day” options should already be set by default, and you 
should set the other options.  Firstly choose “On request…” which will not set an 
alarm for the user but instead simply make the questionnaire available to the user 
when they wake the Diary.  Then set the start and finish times of the time window it 
will be available for.  The suggestion shown is from 5am until midday, which may 
cover typical use.  Then click the “OK” button to create the schedule entry. 
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9.3 Going to Bed 

Next, we need another questionnaire for the user to complete just before they go to 
sleep.  Again, this both collects subjective data, and additionally places a mark in the 
resulting actigraphy data.  The steps required are as follows.  Screenshots will be 
similar to the “Waking Up” section above, and are omitted for brevity. 
 

 Return to the Questionnaire Management window 

 Use Add -> New Questionnaire to create a new questionnaire 

 Fill in the questionnaire name “Lights Out” 

 Click on “Create New Question…” in the questionnaire window 

 Type “Did you feel like falling asleep at any point today?” in the question 
textbox near the top of the window 

 Make sure “Multiple Choice” is selected 

 Click the third mark down to the left of the list of answers to open three boxes 
for answers 

 Type in the answers in the three boxes: 
o Yes, lots 
o Once or twice 
o Not at all 

 Click “Save” to save the question 

 Add more questions if you wish using the “Create New Question…” button. 

 Click on “Save” to save the questionnaire 

 Return to the schedule window (if necessary re-open it by double-clicking on 
the schedule in the Questionnaire Management window) 

 Create a new entry in the schedule as below: 
 

 
  

 Note that the new schedule entry must select the “Lights out” questionnaire, 
not the “Morning” one 

 The new schedule entry should be “on request” for an appropriate evening 
timewindow 

 Click “OK” to create the new schedule entry 
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9.4 Afternoon Tiredness 

If you wish, you may now also create a questionnaire to monitor sleepiness in the 
afternoon.  The questionnaire may be created following a similar procedure to the 
above.  The schedule entry would be different, such as this: 
  

 
 

The “Randomly during the period below” function allows you to avoid consistently 
clashing with the user doing a particular activity at a precise time.  Alternatively you 
can schedule it for a fixed time using the option above.  The user can in either case 
choose to delay the prompt by a few minutes before they answer it. 

9.5 Using the Schedule 

After following the instructions so far, you should have a finished schedule which 
looks similar to this: 
   

 
 

You should use the “Save” button to save this schedule, and can now close the 
Questionnaire Management window entirely. 
  
Connect a PRO-Diary Motion to the PC, and click on the “Set up a Diary” button to 
configure it: 
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Enter the User name as you wish, and ensure the Sleep monitor schedule you have 
created is selected.  You need not select any of the other options – consult the 
normal PRO-Diary Guide to Getting Started for more information.  Then click on “Set 
up Diary”; the software will confirm when it is set up after a minute or two. 
 
Now wear the Diary on the wrist for a few days.  After waking up in the morning: 
 

 Hold your finger over the button to the left of the display for a few seconds 

 Move your finger on the to select “Morning” in the display 

 Select using the button to the right of the display 

 Answer the morning question(s) 
 
You can then continue to wear the Diary throughout the day, and follow similar 
instructions to select the “Lights out” questionnaire before going to sleep in the 
evening.  If you have also added the afternoon entry as suggested, then the Diary 
will beep at you to begin that questionnaire.  
 
When wearing the Diary, you can check the time at any point simply by holding your 
finger over the button to the left of the display for a few seconds.  Place your finger 
there again to turn the display off again.  In this way the Diary can be worn in place 
of a user’s normal watch if they wish. 
  

9.6 Downloading Results 

To download the results from the Diary, first plug it into the PC and start the PRO-
Diary software.  Click on the “Download Results” option from the main menu.  
Confirm if you wish to save to the current results database (doesn’t matter for 
testing, but create a new results database for a genuine study). 
 
Next click “Open Result Viewer” and then double-click on the relevant recording 
which should be at the top of the list of results.  This will allow you to see the normal 
Diary results table (see elsewhere in the User Manual for more details), but also 
contains a button in the top right to export the motion logging results: 
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From this window, you can choose to save the motion data for use in the 
MotionWare analysis software (as a Motion format file), or optionally in an Actiwatch-
compatible format for analysis with your existing sleep software.  The latter format 
will not save some details of the file data, particularly only marking questionnaire 
times to a per-epoch resolution, and having no method of marking data periods 
“missing” rather than simply zero, but is adequate for most analysis.  Note that you 
can save in several formats simultaneously by leaving them selected.  The raw 
recording is also kept in the Diary software, so can be re-exported using this method 
at any point. 
  

9.7 Demonstrating a Timed Questionnaire 

We would recommend that before giving any new wearer the PRO-Diary, you first 
demonstrate to them how to operate the device.  This is easiest using a spare 
device already set up with a single questionnaire on request, and selecting the 
“Enable Demo Beeps” option during setup.  You can then show them: 
 

 How to turn on the device by holding their finger over the left button. 

 That this allows them to read the time. 

 How to select one of the currently available questionnaires, such as Morning. 

 Lead them through answering all the questions in that questionnaire. 

 How the Diary will appear when it is beeping for a timed questionnaire.  This 
can be demonstrated by: 

o Take the Diary from the wearer 
o Wake it using the left button 
o Select the right-most option “System Information” and select it 
o Select the right-most option “Timed demo” and select it 
o Hand the Diary back to the wearer as it beeps 
o Explain how they can then choose either the OK, In a few minutes, or 

Cancel option 
 
It is usually preferable to perform this demonstration using a version of one of the 
questionnaires they will later receive so that they can see both the operation of the 
Diary and the nature of the questions they will be asked at the same time. 

 



 PRO-Diary Guide to Getting Started 1.1 (May 2012)              39 

10 Frequently Asked Questions 
 

What limits the recording life? 
The battery is used mainly whilst the display is on and the user is actually answering 
questions.  When the battery is brand new and fully charged, it will run for around 10 
hours of continuous questioning, equivalent to about 20 minutes per day for one 
month.  However it is possible to design a questionnaire which will take more or less 
of the wearer’s time than this. 
 

Will too many answers fill up the memory? 
No, the answers to questions do not take up a significant part of the memory.  Short 
epoch motion data will take much more memory, but in most cases the recording 
time will be limited by battery life rather than memory. 
 

Will the data be lost if the battery runs flat? 
No.  Plug the device into a USB port to recharge for an hour or so, and try to 
download again.  If you still have difficulty recovering data, contact CamNtech before 
doing anything else with the Diary.  We will do our best to recover data even from 
badly damaged devices.  
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11 Additional Documents 
 

Subsections of this user manual are provided for quick reference from the PRO-
Diary software.  In addition, the document below is provided and can be found from 
the windows Start Menu once the Diary software is installed. 

 
Templates for Cue Cards 

Depending on your users, you may consider printing out and laminating these credit-
card sized guides to give out with the Diary.  These include a few hints to operate 
the Diary.  You might wish to modify them as desired for your application.  
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12 Safety and Handling Information 

12.1 De-contamination 

 Devices used in the field must be considered to be contaminated.  

 Returned devices must be cleaned with alcohol wipes to minimise any 
potential contamination. The operator must use gloves to handle such 
devices before and during de-contamination. 

12.2 Battery 

 The device is battery operated and operates at voltages below 5VDC; there is 
hence no risk from electric shock (equipment Type B). 

 The battery is NOT user replaceable. 

12.3 Water Ingress 

 The PRO-Diary is not waterproof.  When the USB bung is fitted, it should 
withstand accidental splashes in daily use, but the Diary must be removed 
before any greater exposure to water. 

12.4 Disposal 

 
Waste Electrical & Electronic Equipment (WEEE) The EU requires, under the Waste 
Electrical and Electronic Equipment Directive 2002/96/EC, that manufacturers and/or 
distributors of Electronic and/or Electrical Equipment manage and pay for the 
collection and further handling of WEEE products, as well as provide WEEE-related 
information to their customers.  
 
CamNtech has taken the following approach to complying with this Directive: 
 

 CamNtech has registered with an approved producer compliance scheme 
(PCS) in accordance with the requirements of the WEEE Directive. 

 CamNtech will provide free recycling for all of its WEEE products when 
returned to CNT. 

 CamNtech WEEE products will be designed with recycling, reuse and waste 
management as a consideration. 

 CamNtech WEEE products will be labelled or stamped with the WEEE 
marking in accordance with European Standard EN 50419. 
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Appendix A – Installing USB Drivers Manually 
 

Sometimes the automatic installation of drivers will not work, often because your 
computer has previously had similar, but different, drivers installed on it before and 
sometimes because of flaws in the Windows installation process.  To install drivers 
manually, follow the procedure below. 

 

To begin installing drivers: 

 

Plug the device into a USB port.  Something similar to the window shown below 
should appear.  If it does not, then open it manually like this: 
 

 Click on the Start menu, and open the Control Panel. 

 Open ‘System’.  If you can’t see this, choose ‘Performance and Maintenance’, 
then ‘System’. 

 Select the ‘Hardware’ tab, and click the ‘Device Manager’ button. 

 Scroll down and open up the section called ‘Universal Serial Bus controllers’.  
The device you are trying to install should be listed here.  It may have a 
yellow question mark next to it. 

 Right-click on the device name and select ‘Update Driver…’.  The window 
below should then appear. 

 

 

 

 

 

 

 

 

 

 

 

Select ‘No, not this time’ and click ‘Next’.   
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Select ‘Install from a list or specific location (Advanced)’ and click ‘Next’. 

 

 

 

 

 

 

 

 

 

 

 
Select ‘Don’t search.  I will choose the driver to install.’ and click ‘Next’. 
 
The window on the next page should appear.  Sometimes, windows will decide to 
display some other windows first, possibly appearing to lock up for a minute or two 
at one point.  If it does this, you may be forced to choose a device category.  Choose 
any, and look out for the ‘Have Disk..’ button next, which you must find in order to 
proceed. 
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Ignore the items in the list, and click ‘Have Disk…’ instead. 

 

 

 

 

 

 

Click on ‘Browse…’ and then use the standard file window to find the ‘USB drivers’ 
folder on the CD.  Select ‘ftdibus.inf’ from this folder and click on ‘Open’.  The 
window above will re-appear with a filename at the bottom.  Then click ‘OK’. 
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You can now select the correct driver in the list and click ‘Next’.  Depending on your 
system settings, the window below may appear. 

 

 

 

 

 

 

 

If this window appears, click ‘Continue  Anyway’.  The underlying drivers are in fact 
tested and approved by Microsoft, but the certification is invalidated when they are 
configured to match our reader devices. 

 

 

 

 

 

 

 

 

 

 

When this window appears your drivers are installed.   

 

If you still have issues installing the USB drivers then please check our website for 
up to date information, at the link below: 
http://www.camntech.com/drivers 
 
 

http://www.camntech.com/drivers

